# JR PC DATA TRANSFER INSTRUCTION MANUAL

## CONTENTS

1. PRECAUTIONS AND CONFIRMATION ................................................................. 2
2. SYSTEM REQUIREMENTS ............................................................................. 2
3. INSTALLATION ............................................................................................. 3
   3-1 HOW TO INSTALL .................................................................................... 3
   3-2 HOW TO INSTALL DRIVER .................................................................... 4
   3-3 HOW TO CONFIRM CORRECT COMPLETION OF DRIVER INSTALLATION .... 8
4. OPERATION .................................................................................................. 10
   4-1 RECEPTION MODE ON PC (Tx data → PC) ............................................. 10
   4-2 EDITING SAVED DATA ......................................................................... 13
   4-3 HOW TO EDIT ......................................................................................... 13
   4-4 HOW TO SAVE ....................................................................................... 14
   4-5 TRANSMISSION MODE ON PC SIDE (PC Data → Tx) ......................... 14
   4-6 MODEL RESET (R) .................................................................................. 16
   4-7 TERMINATION ......................................................................................... 16
5. MAINTENANCE .............................................................................................. 17
   5-1 HOW TO REINSTALL DRIVER ............................................................... 17
   5-2 HOW TO DELETE THE DRIVER ............................................................ 20
6. UNINSTALLATION .......................................................................................... 22
   6-1 HOW TO UNINSTALL ............................................................................. 22
   WARRANTY ..................................................................................................... 23
1 PRECAUTIONS AND CONFIRMATION

This instruction manual describes how to use the PC Data Transfer software to connect a JR transmitter to a PC. This software allows data editing as well as transmission and reception of data to/from the transmitter.

After unpacking, make sure that the following items are supplied.

PC DATA TRANSFER Dongle
Installation CD
D.S.C. connection cable for transmitter

2 SYSTEM REQUIREMENTS

PC: PC and compatible machines supporting and equipped with
   a USB port and CD-ROM drive
OS: Microsoft® Windows XP®, Windows 2000®
CPU: Intel® Pentium® II 450MHz or better
Memory: 64MB or better
Hard disk space: 150MB or better
Compatible transmitters*: XP9303, X9303 2.4, PCM 10X

*We cannot guarantee that this software will work on every PC even if the system requirements are satisfied.
*Microsoft, Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries.
*Intel, Pentium are registered trademarks of Intel Corporation.
3  INSTALLATION

3-1  HOW TO INSTALL

(Do not connect the USB Data Transfer device to your PC until step 3-2.1)

1. Open the “SET UP.exe” file.

2. When the “Welcome” screen is displayed, click the “Next” button.

3. When “Select Components” screen is displayed, select the component and click the “Next” button. After clicking the button, the installation is started.

4. After the installation is completed, click the “Finish” button.
3-2 HOW TO INSTALL DRIVER

For Windows XP

1. Connect the PC DATA TRANSFER device to the PC.
   * The next screen may not appear depending on the system setting of each PC.
     If that is the case, proceed to Step 3.

2. The “Found New Hardware Wizard” screen will appear. Check the box for “No, not this time” and click the “Next” button.

   * If the auto run function has been disabled at your PC, the “Found New Hardware Wizard” screen does not appear automatically when the PC DATA TRANSFER device is connected. In that case, start up manually in the following manner.

   Open “Device Manager.”

   (1) Right-click “My Computer.”
   (2) Click “Properties.”
   (3) Click the “Hardware” tab in the “System Properties” screen.
   (4) Click the “Device Manager” button.

   When the “Device Manager” screen appears, right-click “Other Devices” and select “Scan for hardware changes.”

   “Found New Hardware Wizard” will start up.
3. Check in the box for “Install from a list or specific location [Advanced]” and click the “Next” button.

4. Confirm that there is a check mark in the box for “Search for the best driver in these locations. Check in the box for “Include this location in the search” and click the “Browse …” button.

5. “Browse for Folder” appears. Opening the folders in order of “My Computer,” “Local Disc(C:),” “Program Files,” “JR PROPO,” “PCDATAtransfer,” and “Drivers,” select a “usbio” folder under the “Drivers” folder and click the “OK” button.

* If you are using Windows XP x64 Edition or Windows Server 2003 x64 Edition, select a “usbio x64” folder under the “Drivers” folder.
6. Confirm that “C:\Program Files\JR PROPO\PCDATAttransfer\Drivers\usbio” is being displayed, click the “Next” button.

* If you are using Windows XP x64 Edition or Windows Server 2003 x64 Edition, “C:\Program Files\JR PROPO\PCDATAttransfer\Drivers\usbio x64” should be displayed.

7. The system will search for the driver.

8. Installing...

9. If the installation finishes correctly, click the “Finish” button

Now, you are finished with driver installation.
For Windows 2000

1. Connect the PC DATA TRANSFER device to the PC.
2. Check in the box for “Search for a suitable driver for my device [recommended]” and click the “Next” button.
3. Check in a box for “Specify a location” and click the “Next” button.
4. Click the “Browse …” button.
5. Open the “usbio” folder screen in order of “My Computer,” “Local Disc(C:),” “Program Files,” “JR PROPO,” “PCDATATransfer,” “Drivers,” and “usbio” to select a “usbio(.inf)” file. Confirm that “usbio(.inf)” is being displayed at “File name:” and click the “Open” button.
6. Confirm that “Copy manufacturer’s files from:” is “C:\Program Files\JR PROPO\PCDATAtransfer\Drivers\usbio, and click the “OK” button.

7. Click the “Next” button. The driver will be searched for, and then installation will start.

8. Once installation is correctly completed, click the “Finish” button.

You are now finished with driver installation.

3-3 HOW TO CONFIRM CORRECT COMPLETION OF DRIVER INSTALLATION

In the following procedure, you can check if the driver has been correctly installed, and if the PC successfully recognizes the PC DATA TRANSFER device.

1. Open Device Manager.

Windows XP and 2000:
(1) Right-click “My Computer.”
(2) Click “Properties.”
(3) Click the “Hardware” tab in the “System Properties” screen.
(4) Click the “Device Manager” button.
2 If the driver has been correctly installed, “USBIO – controlled devices” appears. Click the “+” mark located on the left of “USBIO – controlled devices.” A device name, “USBIO Device,” appears. This state indicates that the driver has been correctly installed, and that the PC successfully recognizes the PC DATA TRANSFER device.

3 If the driver has not been correctly installed, “USBIO – controlled devices” is displayed, but the right screen appears if you click the “+” mark located on the left of “USBIO – controlled devices.” In this state, the PC DATA TRANSFER device has been connected, but the driver may not have been correctly installed. Delete the driver once (see 5-5.2 HOW TO DELETE THE DRIVER) and install it again.

4 If the PC DATA TRANSFER device has not been correctly connected (such as not fully plugged into the USB connector of the PC), “USBIO – controlled devices” will not appear. In this case, an error will result from communication with the transmitter. Make sure that the PC DATA TRANSFER device is properly connected.
4 OPERATION

4-1 RECEPTION MODE ON PC (Tx data → PC)

1. Open “PropoData.exe” contained in the installed folder.

   It is installed in the directory path: “C:\Program Files\JR PROPO\PCDATAtransfer.”

Double-click the icons, “My Computer,” “Local Disc(C:),” “Program Files,” “JR PROPO” and “PCDATAtransfer,” in that order to open the folder.

Execute “PropoData.exe” contained in it.

   It is recommended to create a shortcut on the desktop. This will help you easily start up the application. For a shortcut creating method, right-click “PropoData.exe” to click “Create Shortcut.” Place the shortcut on the desktop to start up the program if desired.

You can also start up the application through “PropoData” in “All Programs” in the “Start” menu.
2. Connect the PC DATA TRANSFER device to the PC. Go into System mode in your compatible JR PROPO transmitter and open the ‘TRANSFER’ function. Go to the ‘TRANSMIT’ function and then connect the DSC lead (from the Data Transfer device) to the transmitter and ‘Power Off’ as instructed.

3. Select “Data Transfer (T)” in the PropoData menu.

4. Select “Data Reception (R)” from the drop down menu.

5. Select “Yes” when it asks “Receive Data”.

6. The communication screen is shown. Press “Start”.
7. Follow the instructions on screen and then select “OK”.

8. Implement the communication using your compatible JR PROPO transmitter.

* If the communication fails, try it again. If it still fails, see “3-3 HOW TO CONFIRM CORRECT COMPLETION OF DRIVER INSTALLATION.”

9. If the communication is completed correctly, the “Save?” message is shown. Click “Yes” if you wish to save the data currently from your transmitter, and click “No” if you don’t. If you answer “Yes” to save your data file, you must choose a sub directory and file name for this data.
10. The data is displayed.

4-2 EDITING SAVED DATA

Select a file that you wish to edit by clicking “Open” in the “File” menu.

4-3 HOW TO EDIT

(1) Numerical value: The numerical values can be changed by using the mouse wheel or the up and down keys of the keyboard.
2. List: If in focus, selection can be done by using the mouse wheel or the up and down keys.

3. Button: If clicked, or if the space key is pressed when in focus, the status of the button is changed.

4. Check: If clicked, or if the space key is pressed when in focus, the status of the check is changed.

5. Change disabled: Change is disabled when grayed out.

4-4 HOW TO SAVE

Select “Save As...” in the “File” menu, if you wish to save the modified data. You can then choose a suitable file name for this altered data.

e.g. VIBE50v2.dat

4-5 TRANSMISSION MODE ON PC (PC Data → Tx)

1. Connect the PC DATA TRANSFER device to the PC.

2. Select “Data Transfer” in the “PropoData” menu.

3. Select “Data Transmission (T)” from the drop down menu.

4. Select “Yes” to the “Send Data” question.

5. Select “Yes” to the question “Send Saved File?”
6. Choose the model data file that you wish to transfer to the transmitter.

7. Enter the System menu on your compatible transmitter and using the MODEL SELECT function select the Model memory that you wish this new data to be transferred to. Then go to the TRANSFER function and select RECEIVE. Connect the DSC lead on the USB Transfer Device and power off as instructed.

8. Press “START” on your transmitter, then “START” on your PC, then if your transmitter says “Standby” select “OK” on your PC. The data will be transferred to your transmitter model memory that you previously selected. Use caution as this will overwrite any information in that model memory in your transmitter.

* If the communication fails, try it again. If it still fails, see “3-3 HOW TO CONFIRM CORRECT COMPLETION OF DRIVER INSTALLATION.”

9. If you wish to transmit the data currently being edited but not yet saved, select “No” to the “Send Saved Data” question, and select “Yes” to “Send the altered data?” The procedure is then the same as described above.
4-6 MODEL RESET (R)
This function will reset the file currently open in PropoData to its default (initial) values.
1. Press “Model Reset (R)” in the menu.
2. Select “Yes” if it is OK to “Reset the Current Page.” This will return all values to zero or their initial value (100% etc).

4-7 TERMINATION
If you wish to terminate (close the application), press “Terminate application” in the “File” menu on your PC.
5 MAINTENANCE

5-1 HOW TO REINSTALL DRIVER

1. Connect the PC DATA TRANSFER device to the PC.
2. Open the device manager. Windows XP and 2000:
   (1) Right-click My Computer.
   (2) Click Properties.
   (3) Click the “Hardware” tab located in the “System Properties” screen.
   (4) Click the “Device Manager” button.
3. Click the “+” mark located on the left of “USBIO controlled devices.”
4. “USBIO-Device” will be displayed.
   Right-click it and click “Driver Update”.

For Windows XP

* The next screen may not appear depending on the system setting of each PC.
If that is the case, proceed to Step 6.

5. The “Hardware Update Wizard” screen is displayed. Select “Yes, now and every time I connect a device” and click the “Next” button.
6. Select “Install from a list of specific Location [Advanced]” and click the “Next” button.

7. Select “Don’t search. I will choose the driver to install”, and click the “Next” button.

* The next screen may not appear depending on the system setting of each PC. If that is the case, proceed to Step 9.

8. Select “USBIO controlled devices” in the “Hardware Type” selection screen and click the “Next” button.

9. Select “USBIO Device” from the items under “Model” and click the “Next” button.
10. Installing...

11. When the installation is completed correctly, click the “Finish” button.

You are now finished with driver reinstallation.

For Windows 2000

5. Click the “Next” button.

6. Select “Display a list of the known drivers for this device so that I can choose a specific”, and click the “Next” button.
7. Select “USBIO Device” out of the items under “Model” and click on the “Next” button.

8. Click the “Next” button.

9. When the installation is completed correctly, click the “Finish” button.

You are now finished with driver reinstallation.

5-2 HOW TO DELETE THE DRIVER

1. Connect the PC DATA TRANSFER device to the PC.

2. Open the device manager. Windows XP and 2000:
   (1) Right-click My Computer.
   (2) Click Properties.
   (3) Click the “Hardware” tab located in the “System Properties” screen.
   (4) Click the “Device Manager” button.
3. Click the “+” mark located on the left of “USBIO controlled devices.”

4. Click the “+” mark located on the left of “USBIO controlled devices.”
When “USBIO-Device” is displayed, right-click it and click the “Delete” button.

5. Then click the “OK” button.
You are now finished with driver deletion.
6 UNINSTALLATION

6-1 HOW TO UNINSTALL

1. From the Start menu, open “Add or Remove programs” in the Control Panel screen.

2. Select “PropoData” and click the “Change/Remove” button.

3. Once the “Confirm File Deletion” screen appears, click “Yes.”

4. The “Remove Programs From Your Computer” screen appears to start uninstallation.

5. Upon completion of uninstallation, click on “OK.”

You are now finished with uninstallation.
Three Year Warranty Period

Exclusive Warranty—Horizon Hobby, Inc., (Horizon) warranties that the Products purchased (the “Product”) will be free from defects in materials and workmanship for a period of 3 years from the date of purchase by the Purchaser.

Limited Warranty

(a) This warranty is limited to the original Purchaser (“Purchaser”) and is not transferable. REPAIR OR REPLACEMENT AS PROVIDED UNDER THIS WARRANTY IS THE EXCLUSIVE REMEDY OF THE PURCHASER. This warranty covers only those Products purchased from an authorized Horizon dealer. Third party transactions are not covered by this warranty. Proof of purchase is required for warranty claims. Further, Horizon reserves the right to change or modify this warranty without notice and disclaims all other warranties, express or implied.

(b) Limitations—HORIZON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, ABOUT NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE PRODUCT. THE PURCHASER ACKNOWLEDGES THAT THEY ALONE HAVE DETERMINED THAT THE PRODUCT WILL SUITABLY MEET THE REQUIREMENTS OF THE PURCHASER’S INTENDED USE.

(c) Purchaser Remedy—Horizon’s sole obligation hereunder shall be that Horizon will, at its option, (i) repair or (ii) replace, any Product determined by Horizon to be defective. In the event of a defect, these are the Purchaser’s exclusive remedies. Horizon reserves the right to inspect any and all equipment involved in a warranty claim. Repair or replacement decisions are at the sole discretion of Horizon. This warranty does not cover cosmetic damage or damage due to acts of God, accident, misuse, abuse, negligence, commercial use, or modification of or to any part of the Product. This warranty does not cover damage due to improper installation, operation, maintenance, or attempted repair by anyone other than Horizon. Return of any goods by Purchaser must be approved in writing by Horizon before shipment.

Damage Limits

HORIZON SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCT, WHETHER SUCH CLAIM IS BASED IN CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. Further, in no event shall the liability of Horizon exceed the individual price of the Product on which liability is asserted. As Horizon has no control over use, setup, final assembly, modification or misuse, no liability shall be assumed nor accepted for any resulting damage or injury. By the act of use, setup or assembly, the user accepts all resulting liability.

If you as the Purchaser or user are not prepared to accept the liability associated with the use of this Product, you are advised to return this Product immediately in new and unused condition to the place of purchase.

Law: These Terms are governed by Illinois law (without regard to conflict of law principals).

Safety Precautions

This is a sophisticated hobby Product and not a toy. It must be operated with caution and common sense and requires some basic mechanical ability. Failure to operate this Product in a safe and responsible manner could result in injury or damage to the Product or other property. This Product is not intended for use by children without direct adult supervision. The Product manual contains instructions for safety, operation and maintenance. It is essential to read and follow all the instructions and warnings in the manual, prior to assembly, setup or use, in order to operate correctly and avoid damage or injury.

Questions, Assistance, and Repairs

Your local hobby store and/or place of purchase cannot provide warranty support or repair. Once assembly, setup or use of the Product has been started, you must contact Horizon directly. This will enable Horizon to better answer your questions and service you in the event that you may need any assistance. For questions or assistance, please direct your email to productsupport@horizonhobby.com, or call 877.504.0233 toll free to speak to a service technician.
Detection or Repairs

If this Product needs to be inspected or repaired, please call for a Return Merchandise Authorization (RMA). Pack the Product securely using a shipping carton. Please note that original boxes may be included, but are not designed to withstand the rigors of shipping without additional protection. Ship via a carrier that provides tracking and insurance for lost or damaged parcels, as **Horizon is not responsible for merchandise until it arrives and is accepted at our facility**. A Service Repair Request is available at www.horizonhobby.com on the “Support” tab. If you do not have internet access, please include a letter with your complete name, street address, email address and phone number where you can be reached during business days, your RMA number, a list of the included items, method of payment for any non-warranty expenses and a brief summary of the problem. Your original sales receipt must also be included for warranty consideration. Be sure your name, address, and RMA number are clearly written on the outside of the shipping carton.

Warranty Inspection and Repairs

To receive warranty service, you must include your original sales receipt verifying the proof-of-purchase date. Provided warranty conditions have been met, your Product will be repaired or replaced free of charge. Repair or replacement decisions are at the sole discretion of Horizon Hobby.

Non-Warranty Repairs

Should your repair not be covered by warranty the repair will be completed and payment will be required without notification or estimate of the expense unless the expense exceeds 50% of the retail purchase cost. By submitting the item for repair you are agreeing to payment of the repair without notification. Repair estimates are available upon request. You must include this request with your repair. Non-warranty repair estimates will be billed a minimum of ½ hour of labor. In addition you will be billed for return freight. Please advise us of your preferred method of payment. Horizon accepts money orders and cashiers checks, as well as Visa, MasterCard, American Express, and Discover cards. If you choose to pay by credit card, please include your credit card number and expiration date. Any repair left unpaid or unclaimed after 90 days will be considered abandoned and will be disposed of accordingly. Please note: non-warranty repair is only available on electronics and model engines.

Electronics and engines requiring inspection or repair should be shipped to the following address:

Horizon Service Center
4105 Fieldstone Road
Champaign, Illinois 61822

All other Products requiring warranty inspection or repair should be shipped to the following address:

Horizon Product Support
4105 Fieldstone Road
Champaign, Illinois 61822

Please call 877-504-0233 with any questions or concerns regarding this product or warranty.